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Device Description 
ALICAM™	
  Software	
  is	
  Infiniti	
  Medical’s	
  proprietary	
  software	
  program	
  used	
  to	
  download	
  and	
  
view	
  ALICAM™	
  images,	
  and	
  to	
  generate	
  detailed	
  reports	
  	
  

 

Indication for Use 
ALICAM™	
  Software	
  is	
  intended	
  to	
  download	
  the	
  images	
  from	
  the	
  ALICAM™	
  capsules,	
  generate	
  
video	
  files,	
  review	
  videos,	
  annotate	
  images,	
  and	
  generate	
  reports	
  	
  

 

Contraindications 
ALICAM™	
  Software	
  has	
  no	
  known	
  contraindications	
  

 

Warnings 
To	
  prevent	
  incorrect	
  reports	
  as	
  result	
  of	
  improper	
  use	
  of	
  the	
  program,	
  please	
  read	
  these	
  
operating	
  instructions	
  carefully	
  before	
  using	
  the	
  ALICAM™	
  Software	
  program	
  	
  
 

Intended Patient Population 
This	
  software	
  is	
  to	
  be	
  used	
  by	
  licensed	
  veterinarians.	
  It	
  is	
  not	
  intended	
  to	
  be	
  used	
  directly	
  by	
  the	
  
animal	
  owners.	
  	
  It	
  is	
  for	
  animal	
  use	
  only	
  and	
  should	
  not	
  be	
  used	
  for	
  human	
  patients	
  

 

Intended Part of the Body or Type of Tissue Applied to or Interacted 
With 
None	
  
 

Intended User Profile 
Veterinarians	
  	
  
 

Intended Conditions of Use 
Veterinary	
  hospitals,	
  veterinary	
  clinics,	
  and	
  veterinarian’s	
  offices	
  
 

Operating Principle 
Displaying	
  images	
  and	
  video	
  for	
  review	
  and	
  diagnosis	
  on	
  a	
  personal	
  computer	
  (PC)	
  	
  
 

Table of Symbols 

Symbol Meaning Symbol Meaning 

 
Manufacturer’s catalog 
designation or number  

Item lot number 
(with accompanying number) 

 
Instructions are included 

and must be followed 
 Manufacturer 

Qty  Quantity  
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1 Introduction 

1.1 Infiniti Medical ALICAM™ System 
The Infiniti Medical ALICAM™ system has three components: 

• ALICAM™ Capsule: A single-use ingestible video capsule that acquires and stores images in 
on-board memory while moving through the patient’s gastrointestinal tract propelled by 
natural peristalsis.  

• ALICAM™ Reader: ALICAM™ Reader includes a Capsule Reader intended to allow trained 
medical personnel to download examination images from the retrieved ALICAM™ capsule 
after the procedure. 

• ALICAM™ Software:  The proprietary software for the management of ALICAM™ examination 
image data. ALICAM™ Software enables download, and easy and accurate review of the 
examination images and efficient report generation.  

1.2 Intended Usage 
After the patient’s owner has retrieved and returned the ALICAM™ Capsule as directed by the 
veterinarian, trained personnel should perform the following steps to download and review the 
examination images and to generate a report: 

1. Connect the ALICAM™ Reader to the workstation PC where ALICAM™ Software is installed. 

2. Place the ALICAM™ Capsule in the ALICAM™ Reader. Please see the ALICAM™ Reader 
Instructions for Use (IFU) for the details of this step. 

3. Use the Download Images function in ALICAM™ Software to download and save the 
examination images in a video file format. 

4. Use the video playback functions in ALICAM™ Software to review the examination images. 

5. Use the image annotation functions in ALICAM™ Software to annotate images of interest. 

6. Use the Generate Report function in ALICAM™ Software to generate the report. 

 



	
   	
  

	
   Document	
  Number:	
  2262	
  	
  	
  Rev:	
  A	
  	
  	
  ECO:	
  15-­‐0010	
  	
  	
  Revision	
  Date:	
  1/22/2015	
   Page	
  6	
  

2 Installation 

2.1 System Requirements 
The ALICAM™ Software can be installed on a computer that meets the following requirements: 
 

CPU Intel Processor with the following specifications based on software usage: 
• For video review, Intel i3 or above  

For download, Intel i5 or i7 
Memory Minimum 2 GB for 32-bit operating system 

Minimum 4 GB for 64-bit operating system 
Operating 
System 

Microsoft Windows 7 (with Service Pack 1) 
Microsoft Windows 8.1 

Display Minimum display resolution of 1680x1050.  
Display resolution of 1920x1080 is recommended 

Additional 
Software 

Software that is capable of displaying a PDF document on your computer 

 

2.2 ALICAM™ Software CD 
The ALICAM™ Software CD contains the following files and programs: 

• ALICAM™ Software Installation Wizard program for installing ALICAM™ Software to your 
computer. 

• ALICAM™ Software Instructions for Use (IFU) document. 

• ALICAM™ Reader USB Driver Installation Wizard program for installing the USB driver for the 
ALICAM™ Reader to communicate with the computer. 

2.3 ALICAM™ Software Download 
Downloaded ALICAM™ software is packaged as a compressed (.zip) file.  The compressed file contains 
the same programs and files as contained on the ALICAM™ software CD. 

To unzip (extract) the downloaded software, follow the below steps: 

For Windows 7 

1 Locate the compressed folder that you want to extract files or folders from. 

2 Right-click the folder, click Extract All, and then follow the instructions. 



	
   	
  

	
   Document	
  Number:	
  2262	
  	
  	
  Rev:	
  A	
  	
  	
  ECO:	
  15-­‐0010	
  	
  	
  Revision	
  Date:	
  1/22/2015	
   Page	
  7	
  

For Windows 8.1 

1 Open File Explorer by swiping in from the right edge of the screen, tapping Search (or if 
you're using a mouse, pointing to the upper-right corner of the screen, moving the mouse 
pointer down, and then clicking Search), entering File Explorer in the search box, and then 
tapping or clicking File Explorer.  

2 Tap or click the Compressed Folder Tools tab, and then tap or click Extract all.   

2.4 Installation of ALICAM™ Software 
Follow these steps to install ALICAM™ Software to your computer: 

Step 1. Login to your computer as an administrator. 

Step 2. If installing from a CD, insert the ALICAM™ Software CD to the CD/DVD drive of your 
computer.  

Step 3. Use the Windows File Explorer to browse the content of the ALICAM™ Software 
CD/Folder, and then right-click AlicamInstaller.exe, then select Run as 
Administrator. 

 

Figure 1. ALICAM™ Software CD 
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Step 4. Click Install/Update ALICAM Software button when the ALICAM™ Software 
Installation Wizard program appears.   

 

Figure 2. ALICAM™ Software Installation Wizard Program 

Step 5. The ALICAM™ Software Installation Wizard will detect if the components of ALICAM™ 
Software have been installed on your computer, and then display the ALICAM™ 
Software Installer dialog box with their installation status. 

Step 6. Install ALICAM™ Software and its required components:  

a. If you are performing a fresh installation of ALICAM™ Software, press the Click Here to 
Start the Installation button, and then follow the on-screen instructions to complete 
the installation process.  The ALICAM™ Software Installation Wizard will guide you 
through the installation of all required components. 
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Figure 3. Install ALICAM™ Software 

b. If you are updating the ALICAM™ Software to the latest version, click the Start Update 
of ALICAM button, and then follow the on-screen instruction to complete the update 
process.  This installer program will remove the previous version of ALICAM™ Software 
and install the latest ALICAM™ Software version from the provided CD or file. 

 

Figure 4. Update ALICAM™ Software 
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Follow these steps if you would like to uninstall ALICAM™ Software: 

a. Windows 7 computers: 

1. Click the Windows  button 
2. Click Control Panel 
3. Click Uninstall a program 
4. Select ALICAM Software 
5. Click Uninstall 
6. Follow the on-screen instructions to complete the un-installation 

b. Windows 8.1 computers: 
1. Find ALICAM Software in Start screen 
2. Right-click ALICAM Software 
3. Click Uninstall 
4. Follow the on-screen instructions to complete the un-installation 

 

2.5 Installation of ALICAM™ Reader USB Driver 
You need to install the ALICAM™ Reader USB Driver only if you are going to use your computer to 
download examination images with the ALICAM™ Reader. Skip this part if you are only using the 
ALICAM™ Software to review and annotate the examination images and to generate reports.  
 
Follow these steps to install (or update) the ALICAM™ Reader USB Driver on your computer: 

Step 1. Connect the ALICAM™ Reader to your computer with the USB cable that comes with 
ALICAM™ Reader. 

Step 2. Insert the ALICAM™ Software CD to the CD/DVD drive of your computer.  

Step 3. Use the Windows File Explorer to browse the content of the CD, right-click 
AlicamInstaller.exe, and then select Run as Administrator. 

Step 4. Click Install ALICAM Reader USB Driver button when the ALICAM™ Software 
Installation Wizard program appears.   

Step 5. The ALICAM™ Reader USB Driver Installation Wizard will detect the operating system 
of your computer, and then display the appropriate installer dialog box. Follow the on-
screen instructions to complete the installation. 

For further information about the use of ALICAM™ Reader, please refer to the ALICAM™ Reader 
Instructions for Use (IFU). 
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3 System Feature Overview 

3.1 Starting ALICAM™ Software 

Click the  icon on your dekstop to start the ALICAM™ Software program. Alternatively, you can 

start it by clicking the  button, All Programs, ALICAM Software folder, and then ALICAM 
Software. 
 

3.2 Main Screen 
The following illustration shows the Main Screen of ALICAM™ Software. 
 

 

Figure 5. Main Screen in Standard Window Mode 

The Main Screen regions are briefly described here. More details on each of the regions are provided 
in later sections of this IFU: 
• ALICAM Menu – Provides access to most ALICAM™ Software functions.   
• Procedure Information – Displays the procedure and patient information and past clinical history 

for the ALICAM™ examination. 
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• Playback Region – Displays the examination video. This is also the region where graphical 
annotations are made while in Annotate Mode. 

• Playback Toolbar – Contains buttons and other controls for the video playback.  
• Position Bar – Displays the current playback position of the video, and color strips that represent 

anatomical gastrointestinal segments.  
• Playback Status Bar – Shows the status information of the video playback.  
• Image List – Displays the captured examination images from the video.  
• Image Comments – Provides text annotation for a single image frame. 
• Findings and Recommendations – Provides the region for the veterinarian to enter the findings 

and summary for the examination report and also the recommendations for future diagnosis and 
treatment. 

 

3.3 ALICAM Menu 
The ALICAM Menu provides access to the following system functions: 

• File 
o Open Video – To open an examination video. 
o Save Findings – To save the annotations you have created/modified for the 

examination video. 
o Save Video As – To save the examination video in another file. 

 

Figure 6. File Menu 

• Download 
o Download Images – To download examination images. 

 

 

Figure 7. Download Menu 
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• Annotate  
o Annotate Mode – To switch between examinations video Playback Mode and image 

Annotate Mode. 
o Ellipse – To select ellipse annotation tool. 
o Arrow – To select arrow annotation tool. 
o Undo – To remove the previous graphical annotation created. 

 

 

Figure 8. Annotate Menu 

• Tools 
o Window Display Mode – To select either standard or full-screen display mode. 
o Generate Report – To generate the report. 
o Finalize Report – To mark a report as finalized. 
o Export Video Clip – To export segment of the examination video to another video file. 
o Edit Procedure Information – To make changes to the procedure information. 
o Transcode – To re-generate the video file from the raw data (.bin) file. 
o Options –To change ALICAM™ Software settings. 

 

 

Figure 9. Tools Menu 

• Help  
o Instructions for Use – To display the IFU document. 
o End User License Agreement – To review the ALICAM™ Software End User License 

Agreement (EULA). 
o About ALICAM – To view the ALICAM™ Software version information. 
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Figure 10. Help Menu 

3.4 Procedure Information  
 

 
Figure 11. Procedure Information  

The Procedure Information displays the procedure and patient information, including the clinical 
history of the patient, entered during the Download Images process.  This region also provides 
opportunity for cross-reference to ensure generation of report for correct patient.  This section also 
provides a user interface to edit the Clinical History, which will be included in the final report.  
 
If you need to make any corrections or edits to the procedure information that was entered during the 
Download Images process, select Edit Procedure Information under the Tools menu. 
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Figure 12. Edit Procedure Information 

You can make any necessary changes to Owner Name, Patient ID, Patient Name, Patient Age, Referring 
Veterinarian, Referring Clinic, Interpreting Veterinarian, Affiliation, Contact Information and Procedure 
Date in this dialog box. To save these changes, enter the required information then click OK. ALICAM™ 
Software will display another dialog box asking you to confirm the changes. 

3.5 Video Playback User Interfaces 

 
Figure 13. Playback Region 
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As the examination images are displayed in the Playback Region, ALICAM™ Software provides 
multiple user interfaces for you to control the video playback: 

• Playback Toolbar  
• Position Bar 
• Mouse clicks in the Playback Region 
• Keyboard 

The Playback Toolbar (located at the bottom of the Playback Region) is depicted in the following 
figure:   

 
Figure 14. Playback Toolbar 

The functions for individual buttons and controls are listed below. 

Table 1. Playback Toolbar buttons 

 

Play 
To play the video at a constant speed specified by the Speed Adjustment control. 
When the video is playing, the Play button will become the Pause button. 
Alternatively, you can also use left mouse click in the Playback Region to switch 
between playback and pause. Place the mouse pointer on the video and left-click 
once to play the video. To pause, left-click again. 
 

 

Play Backward 
To play the video backwards (in reverse) at a constant speed specified by the Speed 
Adjustment control. When the video is playing backward, the Play Backward 
button will become the Pause button. 
Alternatively, you can also use left mouse click in the Playback Region to switch 
between playback and pause. Place the mouse pointer on the video and left-click 
once to play the video backwards. To pause, left-click again. 
 

 

Pause 
To pause the video playback.   

 

Single Frame Backward 
To display the previous frame. Pressing the button repeatedly will cause the video 
to play backward one frame at a time. The scroll wheel of the mouse or the LEFT 
ARROW key can also be used to perform this function. 
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Single Frame Forward 
To display the next frame. Pressing the button repeatedly will cause the video to 
play forward one frame at a time. The scroll wheel of the mouse or the RIGHT 
ARROW key can also be used to perform this function. 
 

 

Capture 
To save the current frame to the Image List.   
It is recommended to pause the video prior to capturing an image.   
Alternatively, the current frame can be captured by double-clicking when the 
mouse pointer is in the Playback Region, or by right-clicking when the mouse is on 
the video and then using the Capture menu. 
 

 
View Mode 
To switch between Normal View (the mode to display a frame in one row, 
essentially 4x1) and Stack View (the mode to display a frame in two rows, 
essentially 2x2).  

 
Magnify  
To display magnified view of 2 of the 4 sub-images.  
Pressing it when in normal mode will display a magnified view of sub-image 1 & 2. 
Pressing it repeatedly will cycle through displaying sub-image 1 & 2, 2 & 3, 3 & 4, and 
then return to a normal view of all sub-images.  

 
Speed Adjustment 
To adjust the playback speed. The playback speed can be set to desired speed by 
moving the slider. The playback speed can be set to from 1X (5 frames per second) 
to 8X (40 frames per second).  
 

 
Jump to Frame 
To jump to a specific frame. Enter the desired frame number of the examination 
video into the text box and then click the Go button or press the RETURN key. The 
video is paused, and then the playback position will move to the frame number you 
entered.  
 

 

Red Detection  
To identify frames which contain red areas in the examination video. When this 
button is pressed, a window opens displaying all the frames that have high 
concentration of red color, if there are any. Click on each frame to display the frame 
of the video in the Playback Region. 
 
Warning: Red detection is to be used as an aid to the reader.  This feature should 
not be relied upon for diagnostic purposes. 
 

 

Gamma Adjustment 
To adjust the gamma parameter to change the image contrast. When this button is 

pressed, the Gamma Adjustment dialog box appears. The gamma setting can be 
made by moving the slider to choose the desired contrast. 
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Annotate 
To switch from Playback Mode to Annotate Mode. This mode change can also be 
achieved by clicking the Annotate Mode in the ALICAM menu. 
 

 

Full-Screen  
To switch from Standard Window mode to Full-Screen mode where only the 
Playback Region, Playback Toolbar, Position Bar, and Playback Status Bar are 
displayed. 

 
The Position Bar and Playback Status Bar are depicted in the following figure: 

 
Figure 15. Position Bar and Playback Status Bar 

The Playback Status Bar provides information on the frame number and transit time.  
 
The Position Bar is a slider that shows the current position in the video. However, it should be noted 
that the position displayed in the Position Bar corresponds linearly to the frame number and not 
necessarily to the transit time, because the frame-capture rate is not constant while the capsule travels 
in the gastrointestinal tract. For example, if the position is at the middle of the slider, the displayed 
frame number will be approximately half the number of the total frames, but this may not represent 
the midpoint of the total transit time. You can also click on the Position Bar to move the video to the 
position indicated by the location of the mouse. Once you are nearby the frame of interest, you should 
pause the video, and then use the Single Frame Forward and Single Frame Backward buttons (or 
scroll wheel of the mouse) to land on the exact frame of interest. 
 
After you have placed the anatomical location for the first gastric image, first duodenal image and first 
cecal image (see 3.6 Annotation User Interfaces), the Position Bar would display color strips that 
represent different anatomical regions in the gastrointestinal tract − blue for stomach, orange for 
small bowel, and green for colon. 

3.6 Annotation User Interfaces 
ALICAM™ Software provides several user interfaces to annotate the examination video: 

• Image List and Image List Toolbar for managing the images to be annotated. 
• Findings and Recommendations and Image Comments for text annotation. 
• Annotate Toolbar for graphical annotation. 
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Before annotating any image, you have to capture the image of interest.  The captured images are 
displayed in the Image List as depicted in the following figure. 

Image List Toolbar

Image List Status Bar

Image List

 

Figure 16. Image List 

The Image List Status Bar displays a summary of the image list at the bottom.   



	
   	
  

	
   Document	
  Number:	
  2262	
  	
  	
  Rev:	
  A	
  	
  	
  ECO:	
  15-­‐0010	
  	
  	
  Revision	
  Date:	
  1/22/2015	
   Page	
  20	
  

Include in Report

Select All

Exclude from Report

Export Image

Delete Image Unmark

First Gastric Image

First Cecal Image

First Duodenal Image

 

Figure 17. Image List Toolbar 

The Image List Toolbar includes the following buttons to manage the images in the Image List.   

Table 2. Image List Toolbar Buttons 

 

Select All 
To select all images in the Image List. 
  

Delete Image 
To delete an image from the Image List. 

 

Include in Report 
To indicate that image will be included 
in the report.  

Mark as First Gastric Image 
To mark an image as the first gastric 
image. 

    

 

Exclude from Report 
To exclude from the report a previously 
included image. 
 

 

Mark as First Duodenal Image 
To mark an image as the first duodenal 
image. 

 

Export Image 
To save an image in a separate PNG or 
JPG image file. 
 

 

Mark as First Cecal Image 
To mark an image as the first cecal 
image. 

 

Unmark Image 
To remove the anatomical location tag 
from an image. 

  

 
Alternatively, you can also access the same functions by right-clicking an image in the Image List, as 
shown in the following figure. 
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Figure 18. Image List Functions 

ALICAM™ Software provides two distinct text annotation regions: Findings and Recommendations 
region is to record the finding summary and recommendations for the entire examination; Image 
Comments region is to record the text annotation for a single image in the Image List.  
 

 
Figure 19. Text Annotation Regions 

 

The Annotate Toolbar provides the graphical annotation for an image. Annotate Mode must be 
enabled in order to use the graphical annotation functions.  Annotate mode can be initiated using the 
ALICAM Menu or by clicking the Annotate button in the Playback Toolbar. 
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Figure 20. Annotate Toolbar 

The Annotate Toolbar is located below the image to be annotated in the Playback Region. 

 

Table 3. Annotate Toolbar Buttons 

 

 

 

 

Ellipse 
To draw an ellipse. 

 

Arrow  
To draw an arrow pointing to an area of interest. 

 

Undo 
To remove a graphical annotation. 

 
Exit 
To exit Annotate Mode and switch back to the Playback Mode. 
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4 Download Images and Generate Examination Video 

4.1 Download Images 
Step 1 – Insert the ALICAM™ Capsule into the ALICAM™ Reader 

• Inspect the inside of the ALICAM™ Reader receptacle and remove any obstructions.  

• Turn ON the ALICAM™ Reader power switch. The light on the system should illuminate. 

• Place the capsule into the ALICAM™ Reader system, battery-end up. 

• Close the lid of the ALICAM™ Reader system. 

Refer to the ALICAM™ Reader Instructions for Use (IFU) for more information. 

Step 2 – Initiate Download 

On the Download menu, click Download Images to start this process.  Download Images is not 
enabled unless ALICAM™ Software detects a properly connected ALICAM™ Reader.  For 
troubleshooting, refer to the ALICAM™ Reader Instructions for Use. After a few seconds, the 
following Procedure Information dialog box appears. 
 

 

Figure 21. Procedure Information Dialog Box 
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Each ALICAM™ Capsule has a unique serial number (SN) that is programmed and stored inside the 
capsule during the manufacturing process. The serial number is also printed on the ALICAM™ Capsule 
package. The user should record the capsule serial number printed on the package into the patient 
chart when giving the capsule to the animal. When you place the capsule in the ALICAM™ Reader and 
start the download process, ALICAM™ Software reads the serial number from the ALICAM™ Capsule 
and displays it in the Capsule SN field. It is recommended to confirm the serial number displayed in 
the Procedure Information dialog box matches that recorded in the patient chart. 
 
The Procedure Information dialog box provides entry for pertinent patient information. At minimum, 
Patient Name, Owner Name, Referring Veterinarian, and Referring Clinic must be entered in order 
to proceed to the next step. In order to select default values to auto-populate in the Interpreting 
Veterinarian, Affiliation and Contact Information fields, enter the desired names in the boxes 
provided and click Save as Default.  The default settings will be effective the next time you use 
Download Images function. 
 
Click Next button after verification of the capsule serial number and all procedure and patient 
information has been entered. ALICAM™ Software will then display a dialog box (as shown in the 
following figure) to confirm the patient information. Click Yes to continue to the next step. Otherwise, 
click No to go back to the Procedure Information dialog box to correct the information. 
 

 

Figure 22. Patient Information Confirmation Dialog Box 

Step 3 – Specify where to save the files 

After confirming patient information, the following Download dialog box appears. 
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Figure 23. Download File Dialog Box 

Using the system settings and the entered information, ALICAM™ Software will automatically assign 
the file names for the download. The Download File dialog box can be used to change the file names. 
The default directory for saving files is C:\alicam_video, which can be changed using the Tools menu. 
Click Next to go to the next step. 

Step 4 – Download in progress 

After confirming the file names, ALICAM™ Software will perform the calibration, and then display the 
following Progress dialog to show the progress of the download and the transcode function. 
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Figure 24. Download Progress Dialog Box 

Step 5 – Complete the download 

After the download is complete, the following dialog box appears. Click Finish to dismiss this dialog 
box. If you check Open Video File, ALICAM™ Software will open this examination video once Finish is 
clicked. 
 

 
Figure 25. Download Completed Dialog Box 

Download may be terminated by clicking the Cancel button anytime in Step 2, 3 or 4. 
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5 Review Examination Video  

5.1 Display Modes 

5.1.1 Standard Window and Full-Screen Modes 
When ALICAM™ Software is started, the Main Screen in Standard Window is displayed, as illustrated 
in Figure 5.  This view provides full access to system functions. ALICAM™ Software also provides an 
alternative Full-Screen mode.  In this mode, the Image List, Procedure Information, Finding Summary 
and Image Comment regions are hidden in order to view the Playback Region with minimal 

distraction. After opening a video, click the Full-Screen button   from the Playback Toolbar to 
get into this mode.  

Switch to Full-Screen mode

Figure 26. Full-Screen Mode Button 

When you are in Full-Screen mode, the Full-Screen button becomes the Standard Window button 

, as illustrated in the following figure. 
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Switch to Standard Window mode

Figure 27. Full-Screen Mode 

5.1.2 Normal View and Stack View Modes 
There are four (4) cameras in the ALICAM™ Capsule that provide a 360o panoramic view of the 
gastrointestinal tract. The four images from these four (4) cameras comprise circumference of the 
gastrointestinal tract. By default, these four images are displayed in a single row. This is called the 
Normal View mode. 
 
The images from the four (4) cameras can also be displayed in two rows, with the left two images 
(images 1 and 2) in the top row and the right two images (images 3 and 4) in the bottom row, as 
shown in the following figure. This display mode, called Stack View mode, provides a narrower 
display width/height aspect ratio.  
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Figure 28. Stack View Mode 

Click the View Mode button  on the Playback Toolbar to switch between these two modes. 

 

5.2 Playback Status 
Both Position Bar and Playback Status Bar (Figure 15) provide status information for the current 
playback. The Position Bar displays the current position in the video graphically.  Once frames are 
marked as the First Gastric Image, First Duodenal Image, and First Cecal Image, color strips will be 
displayed at the bottom of the Position Bar to indicate different segments in the gastrointestinal 
tract: blue for stomach, orange for small bowel, and green for colon. 

Playback Status Bar displays information in text, including frame number, transit time and small 
bowel time. 

Frame number - Indicates the frame number and percentage of frames viewed at the current position 
on the examination video.  

Transit time - Indicates the time travelled by the capsule from the time it was activated until the 
current position. 

If the current position is within small bowel region (between the first duodenal image and the first 
cecal image), the small bowel time and percentage will also be displayed. 

 



	
   	
  

	
   Document	
  Number:	
  2262	
  	
  	
  Rev:	
  A	
  	
  	
  ECO:	
  15-­‐0010	
  	
  	
  Revision	
  Date:	
  1/22/2015	
   Page	
  30	
  

5.3 Controlling the Video Playback 
After opening a video in ALICAM™ Software, start playing the video by clicking the Play button in the 
Playback Toolbar. Once the video starts playing, the Play button will become the Pause button 
allowing for pause during playback. Alternatively, video pause or play can be achieved by clicking 
anywhere in the Playback Region. 

The Play Backward button can be used to return to an earlier portion of the video by playing the 
video in reverse direction. Similar to the Play button, this button will become the Pause button once 
playing the video backward. Alternatively, video pause or play can be achieved by clicking within the 
Playback Region.  

The playing direction (forward or backward) can only be changed through the Play button and Play 
Backward button. 

Single Frame Forward and Single Frame Backward buttons can be used to review the examination 
video frame-by-frame. Pressing the RIGHT ARROW key will have the same effect as clicking the Single 
Frame Forward button while pressing the LEFT ARROW key will have the same effect as clicking the 
Single Frame Backward button. Alternatively, scrolling the mouse scroll wheel provides the same 
function. When the video is paused, scroll the mouse wheel down one click to forward the video one 
frame and scroll the wheel up one click to step the video back one frame.  

The default setting of playback speed is 1X (5 frames per second), which is the lowest playback speed. 
The playback speed can be increased or decreased by moving the Speed Adjustment slider.  

In addition to going through the images sequentially (either forward or backward), ALICAM™ Software 
also provides two features to move to a different position in the video.  Click on Position Bar to move 
the video to the position indicated by the location of the mouse. Alternatively, the Jump to Frame 
allows the user to enter a specific frame number and then click Go button to move to that position in 
the video. 

Use the Gamma Adjustment on the Playback Toolbar to change the image illumination as 
necessary. The default value for gamma is 1.0 and can be adjusted to fit the user needs in viewing any 
particular frames. 
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6 Annotate Images 

Text annotation for this frame

Graphical annotation Switch to Full-Screen modeExit annotate mode

Image ListText annotation for the exam
 

Figure 29. Annotation in Standard Window Mode 

6.1 Capture Image 
Before images can be annotated, the video must be paused and the image captured and saved into 
the Image List.   

There are two ways to capture an image: (1) click the Capture button  in the Playback Toolbar; (2) 
double-click in the Playback Region. With the mouse pointer in the Playback Region, a single-click 
will pause the video if it is playing, or to start playing again if it is paused. Double-click to capture the 
current frame and save it to the Image List when the mouse pointer is in the Playback Region.   

Even though you can capture images while the video is playing, it is recommended that you pause the 
video before capturing the image. Otherwise, the image captured may not be the one intended.  

6.2 Image List 
All captured images are saved in the Image list displayed at the right-hand side of the Main Screen in 
Standard Window mode as illustrated in Figure 29. The thumbnails of these images are displayed in 
the order of the transit time in this list. The frame number, transit time, and text annotation are 
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displayed beneath the thumbnails. If an image is selected to be included in the report, a  symbol 
will display at the lower-left corner of the thumbnail.  If an image is marked as the First Gastric Image, 
First Duodenal Image, or the First Cecal Image, it will also be displayed here. 

The Image List Toolbar, located at the top of the list (Figure 17) can be used to manage the image 
list.  The buttons in this toolbar are discussed in Table 2. 

Use the last button  to unmark the previously marked image.  Alternatively, another image may be 
chosen and marked with the anatomical location. The only restriction for marking an image with an 
anatomical location tag is that the first duodenal image must be in between the first gastric image and 
the first cecal image. 

The alternative way to access these Image List Toolbar functions is to right-click an image in the list, 
the functions will appear as illustrated in Figure 18. 

6.3 Text Annotation 
After you have captured an image, text can be entered as text into the Image Comments region 
(Figure 19). This can be edited immediately after capturing the image or by selecting the image in the 
Image List. Annotate Mode is not necessary to use this function. The title at the top of this region 
indicates the frame for which the description is being entered.  Also, the thumbnail of that image will 
be highlighted in the Image List to indicate that it is selected for text annotation. 

When in Annotate Mode in Full-Screen display mode, the Image Comments region will appear as a 
small text box at the left-hand side of the Annotate Toolbar as illustrated in the following figure. 
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Text annotation Graphical annotation Switch to Standard Window modeExit annotate mode
 

Figure 30. Annotation in Full-Screen Mode 

After reviewing the video and entering annotation for the images, use the Findings and 
Recommendations region (Figure 19) to summarize findings and issue recommendations.  After 
which the report can be generated.   

6.4 Graphical Annotation 
In addition to text annotation, graphical annotations on the images can be made.  After capturing an 
image or selecting an image in the Image List, click the Annotate button on the Playback Toolbar to 
enter the Annotate Mode. Alternatively, on the Annotate menu, click Annotate Mode.  

In Annotate Mode, instead of the Playback Toolbar, the Annotate Toolbar will appear in order to 
draw ellipses or arrows on the image. 

To draw an arrow on an image, select the arrow drawing tool by clicking the Arrow button  in the 
Annotate Toolbar. Move the mouse pointer to the location in the image where one end of the arrow 
will be, press the left button of the mouse, move the mouse (without releasing the left button) toward 
the desired resting place of the arrow head and then release the mouse button.  The arrow will now be 
drawn on the image. Similarly, an ellipse can be drawn in the same way by selecting the Ellipse button 

 first.  To erase the previously created graphical annotation, click the Undo button  on the 
Annotate Toolbar. 

These annotate functions are also available on the Annotate menu. 
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6.5 Saving Annotation 
When you click the Save Findings menu item, ALICAM™ Software will save all annotation data 
(captured images with graphical and text annotation, finding summary and recommendations) in a 
file with the same name as the video, but with CVA file extension. This file is saved in the same folder 
as the video file. 

It is important that both the video file and the CVA annotation file are saved with the same name in 
the same file location. 

When you click the Open Video menu item, ALICAM™ Software will look for this annotation file and 
display the annotation. If you have accidentally renamed the annotation file, but still keep it in the 
same folder and still keep the CVA file extension, ALICAM™ Software can still find it and display the 
annotation. However, if you have deleted it or moved it to another folder, ALICAM™ Software will 
display the video without any annotation. 
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7 Generate Reports 
ALICAM™ Software allows users to generate two types of reports: a draft report and a finalized report. 
The draft report allows users to preview a report, while a finalized report will mark the video as read-
only, preventing further changes. 

7.1 Finalize Report 
When you are sure that you have correctly entered all information for the exam, you can mark the 
report as finalized so that you can generate the finalized report and prevent it from further editing. On 
the Tools menu, click Finalize Report to mark a report as finalized. If you have not entered minimum 
required data, an error message, similar to the one shown in Figure 31, will appear.  
 

 

Figure 31. Error Checking Before Finalize Report 

If you have entered minimum required data, the following dialog will appear to ask you to confirm. 

 

Figure 32. Confirmation for Finalizing Report 

After you confirm the decision to finalize the report, ALICAM™ Software will switch to read-only mode, 
then display the following warning message. Whenever you try to open a video with finalized report, 
ALICAM™ Software will display the same message to remind you that you are viewing this video in 
read-only mode. 
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Figure 33. Warning Message in Opening a Finalized Exam 

7.2 Generate Report 
On the Tools menu, click Generate Report to create a PDF report using the annotated images 
selected to be included in the report.  The following dialog box will appear.   
 

 

Figure 34. Report Generation Dialog Box 

 
Font size can be changed using the Report Font Size box.  

Assign the saved report location by using Change File to start the Windows File Explorer to navigate 
to the desired folder.  Enter the desired name of the file in this location. 

Clicking the OK button will generate the report.  

ALICAM™ Software will generate the report and display it in PDF Reader.  If the report is still in draft 
status, a “DRAFT” watermark will appear in the report as shown in Figure 35.  If the report has been 
marked as finalized, the report footer will include the date and time when the report was finalized by 
the veterinarian, as shown in Figure 36. 
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Figure 35. Example Draft Report 
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Figure 36. Example Finalized Report 
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8 Export Video Clips and Images 

8.1 Export Video Clips 
On the Tools menu, click Export Video Clip to export and save a segment of the examination video to 
another file. The following dialog appears. Enter the start frame, end frame, output file name, and 
whether to mask the procedure info. Click the Next button to generate the video. 
  

 

Figure 37. Export Video Clip 

The numbers in Start Frame and End Frame indicate the video segment to be included in this video 
clip. Click the Browse button to start the Windows File Explorer to select the folder and file name to 
save the video.  The default, Mask Procedure Info is checked to indicate that the procedure and 
patient information will not be included in the video clip to protect patient privacy.  Uncheck this box 
to include that in the video clip. The finding summary and recommendation and image annotations 
will not be included in the exported video clip; only the original images for the selected video 
segment will be included. 
 

8.2 Export Images 
An image can be exported and saved to a separate PNG or JPG file by clicking the Export Image 

button (  in the Image List Toolbar) after selecting an image in the Image List. The following 
dialog box will appear to input the location to save the file. As the default, the file will be saved in PNG 
format, which has a better quality. Click Save As Type to change it to save the image in JPG format, 
which is compatible with most computer programs. 
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Figure 38. Export Image Dialog box 
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9 Change System Settings 
There are several system settings in ALICAM™ Software that you can change to fit the operating 
environment and user preference. On the Tools menu, click Options to display the dialog box for 
changing the system settings. This dialog box includes two tabs that are described in the following 
sections. 

9.1 Mouse 
Instead of playing the video at a constant speed or using the Single Step Backward and Single 
Frame Forward buttons on the Playback Toolbar, the scroll wheel on the mouse may be utilized to 
control the video playback. With the default setting, after pausing the video, scrolling up the wheel 
has the same effect as pressing the Single Step Back button. Similarly, scrolling down the wheel has 
the same effect as pressing the Single Frame Forward button. The direction setting can be changed 
using the dialog box illustrated in the following figure. 

  

Figure 39.  Change Mouse Setting 

Simply choose the desired setting, and then click OK to save the change. The change is effective 
immediately after you saved it. 

9.2 Report Generation 
Even though the font size can be changed every time you want to generate a report, default values 
can be set via the dialog box illustrated in the following figure. 
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Figure 40.  Change Default Report Setting 

To change the default font size, simply select the desired size. After you make the changes, click OK to 
save the changes. The changes are effective immediately. 
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10 Training 
Users can contact Infiniti Medical or its Authorized Representatives for training on how to use the 
ALICAM™ Software application. Contact information is listed at the end of this document. 
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11 Getting Help and Troubleshooting 
This document is available in the ALICAM™ Software program in the Help menu, or by pressing the F1 
key. Other language versions are available on the ALICAM™ Software CD. 

Please refer to ALICAM™ Reader Instructions for Use (provided with the ALICAM™ Reader System) 
for connecting the ALICAM™ Reader to your computer and for download images. 

The following table provides common issues and their resolution: 

Issue Resolution 

Some screens have been cut off  • Make sure that your computer screen resolution is 1680 x 1050 
or higher 

Captured image is not the one 
that you intended to capture 

• Pause the video before capturing an image 

Download Images menu is 
disabled 

• Make sure that the ALICAM™ Reader USB Driver is installed on 
this computer 

• Make sure the ALICAM™ Reader is turned on and is connected 
to the computer using the provided USB cable 

• Make sure the ALICAM™ Capsule in the ALICAM™ Reader is 
properly aligned 

• Try to turn off and then turn on the ALICAM™ Reader 
Error message appears during 
download 

• Make sure the ALICAM™ Reader is properly connected to the 
computer using the provided USB cable 

• Turn off the ALICAM™ Reader and then turn it back on. Re-align 
the ALICAM™ Capsule and then retry the download. 

Problem in installing ffdshow • Make sure you use “Run as administrator” option in using the 
installer program 

Problem in installing ALICAM™ 
Reader USB driver 

• Make sure you use “Run as administrator” option in using the 
installer program 

• Check Infiniti Medical website to ensure you are using the latest 
version of the ALICAM™ Software to install the most current 
driver 

 

Please refer to Infiniti Medical web site for additional help and trouble shooting for using ALICAM™ 
Software. 

Please include the following information if you are reporting a problem or requesting assistance from 
Infiniti Medical or its Authorized Representatives: 
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• Computer hardware specification. 
• Version of the operating system on the computer. 
• ALICAM™ Software version. 
• Description of error situation, including screen shots when appropriate. 
• Steps taken leading up to the error.   
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Warnings 
To prevent incorrect reports as result of improper use of the program, please read these operating 
instructions carefully before using the ALICAM™ Software program. 
 
Storage 
The ALICAM™ Software is stored on a CD. The CD should be kept in a cool dry location under normal 
environment conditions. 

Warranty 
Refer to the Warranty section in the End User License Agreement, which is available under the Help menu in 
ALICAM™ Software program. 
 

Contact Information: 

 Manufactured for Infiniti Medical 

Infiniti Medical, LLC 
525 Middlefield Road, Suite 150 
Menlo Park, CA  94025, U.S.A. 
Telephone: 1-(650) 327-5000 
www.infinitimedical.com 

Email: sales@infinitimedical.com 
 
 

 


